Important Information

Warranty
NI RF Vector Signal Analyzer hardware modules are warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of the document without notice to holders of this document. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

Except as specified herein, National Instruments makes no warranties, express or implied, and specifically disclaims any warranty of merchantability or fitness for a particular purpose. Customer’s right to recover damages caused by fault or negligence on the part of National Instruments shall be limited to the amount thereof paid by the customer. National Instruments will not be liable for damages resulting from loss of data, profits, use of products, or incidental or consequential damages, even if advised of the possibility thereof. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on ni.com/legal for more information about National Instruments trademarks.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help>Patents in your software, the patents.txt file on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS

(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFERS FROM NATIONAL INSTRUMENTS’ TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
Contents

About This Manual
Conventions ................................................................................................................... vii
Related Documentation.................................................................................................. viii
How to Use this Documentation Set .............................................................................. viii

Chapter 1
Getting Started with the RF Vector Signal Analyzer
Verifying System Requirements ................................................................................... 1-1
Unpacking ...................................................................................................................... 1-1
Verifying Kit Contents ................................................................................................... 1-2
Installing the Software ................................................................................................... 1-5

Chapter 2
Hardware Installation
Interconnecting the Modules ......................................................................................... 2-4
NI 5660 Connections .................................................................................................... 2-4
NI 5661 Connections .................................................................................................... 2-6
Running Measurement & Automation Explorer ............................................................. 2-7

Chapter 3
Configuring and Programming Your NI 5660
Acquiring Data Interactively ......................................................................................... 3-2
Configuring Hardware Programmatically ..................................................................... 3-6
Programming the RF Vector Signal Analyzer in LabVIEW .......................................... 3-6
  ni5660 LabVIEW VIs Programming Flow ................................................................. 3-6
  Frequency-Domain Measurements Programming Flow .............................................. 3-7
  IQ Acquisition Programming Flow ............................................................................. 3-7
Example Applications for LabVIEW ............................................................................... 3-8
Programming the RF Vector Signal Analyzer in LabWindows/CVI and C ................. 3-8
Introduction to the Spectral Measurements Toolkit ....................................................... 3-10
  SMT Example Applications for LabWindows/CVI and C .......................................... 3-10
About This Manual

This guide explains how to install, configure, test, and begin using an RF vector signal analyzer, and introduces programming methods and examples. Additional documents, such as help files (which include the function reference information) and specifications documents, are accessible from Start»Programs»National Instruments»NI-RFSA»Documentation.

This document provides information for customers using either an NI 5660 or NI 5661 RF vector signal analyzer. Refer to the How to Use this Documentation Set section for more information about which portions of this document and other documents apply to your device.

Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menus to a final action. The sequence File»Page Setup»Options directs you to pull down the File menu, select the Page Setup item, and select Options from the dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such as menu items and dialog box options. Bold text also denotes parameter names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept. Italic text also denotes text that is a placeholder for a word or value that you must supply.

monospace Text in this font denotes text or characters that you enter from the keyboard. This font is also used for the proper names of paths, directories, programs, functions, operations, variables, and filenames.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value that you must supply.
About This Manual

Text in this font denotes a specific platform and indicates that the text following it applies only to that platform.

Related Documentation

The following documents contain information that you may find helpful as you read this manual:

- **NI RF Signal Analyzers Readme**—This HTML document includes information about the minimal and recommended system requirements, new features, installed file locations, and uninstalling/modifying the NI-RFSA driver software.

- **NI RF Vector Signal Analyzers Help**—Use this online help file to operate NI 5661 RF vector signal analyzers.

- **NI PXI-5660 Help**—Use this online help file to operate NI 5660 RF vector signal analyzers.

- Specifications document for your device—a printed document ships with both devices and provides additional hardware information.

- **NI High-Speed Digitizers Help**—Use this online document, located at Start\>Programs\>National Instruments\>NI-SCOPE\>Documentation, to learn more information about the IF digitizer module included as part of your RF vector signal analyzer.

How to Use this Documentation Set

This document provides information about how to install, configure, test, and begin using either an NI 5660 or NI 5661 RF vector signal analyzer. Chapters 1 and 2 relate to unpacking either device and installing software and hardware. Chapter 3 pertains to configuring and programming only the NI 5660 RF vector signal analyzer, and Chapter 4 pertains only to the NI 5661. Each device also has its own help file, as described in the preceding Related Documentation section.

**Note** The NI-RFSA 2.0 software installation provides support for customers using either an NI 5660 or an NI 5661 RF vector signal analyzer. To program the NI 5661, use the NI-RFSA API in all programming languages. To program the NI 5660, use the ni5660 API in LabVIEW and the NI-Tuner and NI-SCOPE APIs in other programming languages.
Getting Started with the
RF Vector Signal Analyzer

Verifying System Requirements

Your system must meet certain requirements to use NI RF vector signal analyzers. For more information on minimum system, recommended system, and supported application development environments (ADEs), refer to the NI-RFSA Readme, which is available on the NI-RFSA CD.

Note After you install NI-RFSA, you can access the NI RF Signal Analyzers Readme at Start>All Programs>National Instruments>NI-RFSA>Documentation or online at ni.com/downloads.

Unpacking

Both hardware modules of the RF vector signal analyzer ship in antistatic packages to prevent damage from electrostatic discharge (ESD). Because ESD can damage several components of both hardware modules, store both modules in the antistatic envelopes when not in use.

Caution Never touch exposed connector pins.

To avoid damage in handling the RF vector signal analyzer hardware modules, take the following precautions:

- Ground yourself using a grounding strap or by touching a grounded object.
- Touch the antistatic package to a metal part of your computer chassis before removing the hardware module from the package.

Remove each hardware module from the package and inspect it for loose components or any signs of damage. Notify NI if either hardware module appears damaged in any way. Do not install a damaged module into your system.
Chapter 1  Getting Started with the RF Vector Signal Analyzer

Verifying Kit Contents

You need the following items to set up and use the RF vector signal analyzer. Listboxes represent physical kit items, as shown in Figure 1-1.

- Driver software CD—installs the NI-RFSA and NI-5660 driver software and online documentation for your device.

  Note  The NI-RFSA 2.0 software installation provides support for customers using either an NI 5660 or an NI 5661 RF vector signal analyzer. To program the NI 5661 use the NI-RFSA API in all programming languages. To program the NI 5660 use the ni5660 API in LabVIEW and the NI-Tuner and NI-Scope APIs in other programming languages.

- NI Spectral Measurement Toolkit CD—installs the Spectral Measurements Toolkit (SMT) software components, which includes SMT VIs and functions, examples, and documentation.

- Two hardware modules:
  - IF digitizer module—NI 5620 module (for NI 5660 users) or NI 5142 (for NI 5661 users)
  - NI 5600 RF downconverter module

- Short cables for module interconnects
  - For NI 5660 users
    - One short, semi-rigid SMA-to-SMA coaxial cable
    - One long, semi-rigid SMA-to-SMA coaxial cable
    - One semi-flexible SMA-to-SMA coaxial cable
  - For NI 5661 users
    - One semi-flexible SMA-to-SMB coaxial cable
    - One semi-flexible SMA-to-BNC coaxial cable
    - One semi-flexible SMA-to-SMA coaxial cable

- 1/8 in. combination Phillips/flathread screwdriver

- Plastic collars (cable wrenches) for gripping the coaxial cable hex connectors

- The following printed documentation:
  - RF Vector Signal Analyzers Getting Started Guide (this document)
Specifications document for your device

In addition to the kit contents, you need the following items to set up the RF vector signal analyzer:

- A PXI chassis with at least four empty slots
- A PXI embedded or MXI-3 controller system that meets the system requirements specified in this guide
- A 100 N-cm standard SMA torque wrench (recommended)
Chapter 1  Getting Started with the RF Vector Signal Analyzer

Figure 1-1. Required Parts Inventory and Replacement Part Numbers

1  NI PXI-1042 or PXI-1045 Chassis (not included)
2  NI 5600 RF Downconverter Module
3  NI 5620 IF Digitizer Module (NI 5660 only)
4  NI 5142 IF Digitizer Module (NI 5661 only)
5  Short, Semi-Rigid SMA-to-SMA Cable (NI 5660 only)
6  Long, Semi-Rigid SMA-to-SMA Cable (NI 5660 only)
7  Semi-Flexible SMA-to-SMA Cable
8  Semi-Flexible SMA-to-SMB Cable (NI 5661 only)
9  Semi-Flexible SMA-to-BNC Cable (NI 5661 only)
10 Cable Wrenches (2)
11 Screwdriver
12 100 N-cm SMA Torque Wrench (not included)
Installing the Software

Complete the following steps to install the contents of the driver software CD. You must install all of the included software before installing any RF vector signal analyzer hardware.

1. Install a development environment such as LabVIEW, LabWindows™/CVI™, or a third-party program according to its instructions. Any development environment you intend to use must be installed before you install the driver software and the Spectral Measurements Toolkit.

2. Insert the NI-RFSA 2.0 CD into the CD drive and follow the instructions in the installation window. You can choose to install **NI-RFSA 2.0 (NI PXI-5661)** and/or **NI PXI-5660 Support**.

   **Note** If the installation window does not appear, navigate to the CD drive, and double-click `setup.exe`.

3. When installation completes, remove the driver software CD.

   **Note** You must install the driver software before installing the Spectral Measurements Toolkit.

4. Insert the Spectral Measurements Toolkit CD.

5. Click **OK**.

   **Note** For full functionality, you must install the Spectral Measurements Toolkit packaged with the RF vector signal analyzer. The Spectral Measurements Toolkit extends the capability of the RF vector signal analyzer to include frequency- and modulation-domain measurements, and analysis of analog- and digitally-modulated IF signals.

6. Install any additional software that you intend to use with the RF vector signal analyzer after installing the driver software and the Spectral Measurements Toolkit.

   If toolkits or other software that you intend to use with the RF device were installed before you installed the driver software, repeat or repair those installations after installing the driver software and Spectral Measurements Toolkit.
Note  The Spectral Measurements Toolkit includes examples for analog modulation and demodulation. For digital modulation and demodulation measurement functions, you can purchase and install the NI Modulation Toolkit.
Hardware Installation

Installation of both RF vector signal analyzer hardware modules requires four vacant PXI slots—three slots for the NI 5600 downconverter module and one slot for the IF digitizer module. The IF digitizer must be installed in the slot immediately to the right of the NI 5600 to use the included coaxial cables.

Note: The published specifications document for your RF vector signal analyzer assumes use of the included cables. Substituting different cables may affect performance.

The NI 5600 onboard frequency reference can drive the PXI backplane clock only if the downconverter module is installed in PXI Slot 2. When the NI 5600 is installed in PXI Slot 2, you can configure it to lock the PXI backplane to the highly accurate and stable NI 5600 onboard OCXO, or to an external frequency reference clock signal connected to the FREQ REF IN connector on the NI 5600 module front panel.

1. Install the NI 5600 by completing the following steps:
   a. Power down your PXI chassis.
   b. If the chassis has multiple fan speed settings, ensure that the fans are at the highest setting. Do not set the fan speed to low or turn the fan off.
   c. Position the chassis so that you allow plenty of space between the chassis fan intake and exhaust vents. Blockage by walls or obstructions affects the air flow needed for cooling. For more information, refer to the chassis documentation.
   d. Remove the rubber screw covers from the six captive screws in the module front panel.

   Note: The NI 5600 must be installed in PXI Slot 2 to drive the PXI backplane with the NI 5600 onboard OCXO reference clock or an external reference clock signal.

   e. Holding the module by the ejector handle, slide the NI 5600 into an available PXI slot, ensuring that the base card (on the left when looking at the front of the module) engages with card guides in the chassis.
f. Slide the module completely into the chassis and latch by pulling up on the ejector handle.

g. Tighten the six screws in the module front panel.

Figure 2-1. Install the NI 5600 RF Downconverter Module

2. Install the IF digitizer module in the adjacent PXI slot immediately to the right of the NI 5600 downconverter module by completing the following steps:

   a. Remove the rubber screw covers from the two captive screws in the module front panel.
b. Insert the digitizer module into the slot immediately to the right of the NI 5600 downconverter module, as shown in Figure 2-2. To insert the module, repeat steps 1e through 1g.

Figure 2-2. Install the NI 5620 IF Digitizer Module

Caution Inadequate air circulation could cause the temperature inside the chassis to rise above the optimal operating temperature for the RF Vector Signal Analyzer hardware modules, potentially causing thermal shutdown, shorter lifespans, or improper performance.

3. Install all chassis covers and filler panels after installing the RF vector signal analyzer hardware modules. Missing filler panels disrupt necessary air circulation in the chassis.
Note (Optional) NI recommends installing slot blockers in adjacent vacant PXI slots to maximize cooling air flow to the RF Vector Signal Analyzer hardware modules.

Interconnecting the Modules

The following sections describe how to interconnect the RF downconverter and IF digitizer front panels.

NI 5660 Connections

Complete the following steps to interconnect the RF vector signal analyzer hardware module front panel connectors as shown in Figure 2-3.

1. Using the short semi-rigid coaxial cable, connect the OUTPUT connector on the NI 5600 downconverter front panel to the INPUT connector on the NI 5620 IF digitizer front panel.

   Note The semi-rigid cables must be installed so the bends point upwards, as shown in Figure 2-3.

2. Using the long semi-rigid coaxial cable, connect the lower of the two 10 MHz OUT connectors on the NI 5600 front panel to the REF CLK IN connector on the NI 5620 front panel.

3. (Optional) Using the semi-flexible coaxial cable, connect the bidirectional PXI 10 MHz I/O connector on the NI 5600 front panel to the other 10 MHz OUT connector on the NI 5600 front panel.

   The connection between the 10 MHz OUT connector and the PXI 10 MHz I/O connector on the NI PXI 5600 front panel is required only when you want to drive the PXI backplane with the NI 5600 onboard frequency reference. If you want to receive the 10 MHz reference signal from the PXI backplane, move the cable from the 10 MHz OUT connector to the FREQ REF IN connector.

4. Carefully tighten all SMA connectors to 100 N-cm using an SMA torque wrench (not included) as shown in Figure 2-3. Tighten only until the wrench clicks.

5. Power on your PXI chassis and controller system.
6. Verify that the POWER LED on the NI 5600 downconverter module is illuminated. If the LED is not illuminated, refer to Appendix B, Troubleshooting.

Caution Incorrect torque at SMA connections can degrade signal fidelity, PLL performance, and insertion loss. Use an SMA torque wrench to ensure all SMA connections are properly torqued to 100 N-cm.

Figure 2-3. Installation of Included NI 5660 Cables
NI 5661 Connections

Complete the following steps to interconnect the RF vector signal analyzer hardware module front panel connectors as shown in Figure 2-4.

1. Using the short SMA-to-BNC coaxial cable, connect the OUTPUT connector on the NI 5600 downconverter front panel to the CH 0 connector on the NI 5142 IF digitizer front panel.

Figure 2-4. Installation of Included NI 5661 Cables
2. Using the long SMA-to-SMB coaxial cable, connect the lower of the two 10 MHz OUT connectors on the NI 5600 front panel to the CLK IN connector on the NI 5142 front panel.

3. (Optional) Using the semi-flexible coaxial cable, connect the bidirectional PXI 10 MHz I/O connector on the NI 5600 front panel to the other 10 MHz OUT connector on the NI 5600 front panel.
   The connection between the 10 MHz OUT connector and the PXI 10 MHz I/O connector on the NI PXI 5600 front panel is required only when you want to drive the PXI backplane with the NI 5600 onboard frequency reference. If you want to receive the 10 MHz reference signal from the PXI backplane, move the cable from the 10 MHz OUT connector to the FREQ REF IN connector.

   Note Refer to Appendix A, *Hardware Front Panel Connectors and Indicators*, for more information on RF Vector Signal Analyzer hardware front panel connectors.

4. Carefully tighten all SMA connectors to 100 N-cm using an SMA torque wrench (not included) as shown in Figure 2-3. Tighten only until the wrench clicks.

5. Power on your PXI chassis and controller system.

6. Verify that the POWER LED on the NI 5600 downconverter module is illuminated. If the LED is not illuminated, refer to Appendix B, *Troubleshooting*.

   Caution Incorrect torque at SMA connections can degrade signal fidelity, PLL performance, and insertion loss. Use an SMA torque wrench to ensure all SMA connections are properly torqued to 100 N-cm.

---

**Running Measurement & Automation Explorer**

Measurement & Automation Explorer (MAX) is used to configure your National Instruments hardware. You must run MAX at least once after hardware installation to ensure that other programs are informed about which devices reside in the system and how they are configured. MAX is automatically installed by the driver software CD.

   Note MAX treats the NI 5600 RF downconverter module and the IF digitizer module as separate devices.
Configuring and Programming Your NI 5660

To use MAX to configure, self-test, and functionally test the RF Vector Signal Analyzer hardware modules, complete the following steps:

1. Launch MAX by navigating to Start>Programs>National Instruments>Measurement & Automation or by clicking the MAX desktop icon.

2. In the Configuration pane, double-click Devices and Interfaces to see the list of installed devices.

3. Expand the Traditional NI-DAQ Devices folder. You will see a list of installed devices that includes the NI 5600 and NI 5620 modules (your default device names may vary).

4. Note the device numbers assigned to your RF vector signal analyzer hardware modules by MAX. These numbers are used when programming the RF vector signal analyzer.

Note If you do not see the NI 5600 and NI 5620 modules listed, refer to Appendix B, Troubleshooting.

5. Note the device numbers assigned to your RF vector signal analyzer hardware modules by MAX. These numbers are used when programming the RF vector signal analyzer.

6. The Configuring Device dialog box appears. Click Test Resources to self-test the NI 5600 RF downconverter hardware module.

7. The NI-DAQ Configuration Utility dialog box appears to confirm your self-test. Click OK to return to the Configuring Device window.

The MAX self-test performs a basic verification of hardware resources. Complete steps 5 through 11 to self-test both modules.

Note When programming the RF Vector Signal Analyzer, specify the NI 5620 IF digitizer module using the DAQ Resource Name with the following syntax: DAQ::DeviceNumber. Specify the NI 5600 downconverter module using the MAX device number without modifiers.
8. In the NI 5600 Configuring Devices dialog box, click OK to return to MAX.

9. Right-click NI 5620 and select Properties.

10. The Configuring Device dialog box appears. Click Test Resources to self-test the NI 5620 IF digitizer hardware module.

11. The NI-DAQ Configuration Utility dialog box appears. Click OK to return to the Configuring Device window and continue with the NI 5620 test panel.

Note If the NI 5620 IF digitizer module fails the self-test, refer to Appendix B, Troubleshooting.

You have completed setup, configuration, and testing of the NI 5660 RF vector signal analyzer.

**Acquiring Data Interactively**

To interactively acquire data and perform measurements with the RF vector signal analyzer, use the included RF Signal Analyzer Demo Panel. The RF Signal Analyzer Demo Panel is accessible from within MAX at Tools»Soft Front Panels»NI5660 - RFSA Demo Panel and from the Start menu at Start»Programs»National Instruments»NI-RFSA»5660 Demo Panel.

Tip If an external signal source is not available, the signal output from the 10 MHz OUT connector on the NI 5600 RF downconverter module front panel can be used as a source to verify proper RF vector signal analyzer installation and as a live signal for the RF Signal Analyzer Demo Panel. To use this signal, connect the 10 MHz OUT connector to the INPUT connector on the NI 5600 RF downconverter module front panel.
The RFSA Demo Panel (shown in Figure 3-1) provides a convenient software interface with which you can operate the RF Vector Signal Analyzer hardware to perform common frequency-domain and IQ measurements.

**Tip** Press `<Ctrl-H>` to view context-sensitive help for all RF Signal Analyzer Demo Panel controls and indicators.

To use the RF Signal Analyzer Demo Panel, configure the following controls:

1. Verify that the device numbers in the RFSADeviceNumbers dialog box reflect those assigned to the RF vector signal analyzer hardware modules in MAX, and click **OK**.
2. The **Hardware Settings** controls specify hardware parameters for your measurement, including the following:
   - RF Spectrum Settings
   - Amplitude
   - Timing
   - Advanced Spectral Parameters
   - Devices

3. The **Measurements** controls specify the measurement you want to perform. Choose one of the following options:
   - Peak Search
   - Delta Peak
   - Power in Band
   - Adjacent Channel Power (ACP)
   - Occupied Bandwidth
   - IQ Data

4. The **Averaging Type** controls specify averaging applied to returned data. Figure 3-2 illustrates the hierarchy of options for spectrum averaging.
Figure 3-2. RFSA Demo Panel Spectrum Averaging Options

5. The **Units** controls specify units in which to return measurement results. Several commonly used units are available.
Configuring Hardware Programmatically

Two paradigms are available to programmatically configure the RF vector signal analyzer hardware for data acquisition, as shown in Table 3-1.

Table 3-1. Programmatic Configuration Paradigms for RF Vector Signal Analyzer Hardware

<table>
<thead>
<tr>
<th>Programming Paradigm</th>
<th>Benefits</th>
<th>ADE Support</th>
</tr>
</thead>
</table>
| ni5660 VIs                                    | • Ease of use from a higher-level application programming interface: both RF Vector Signal Analyzer hardware modules controlled as a single instrument  
• Addresses common frequency-domain and IQ measurement applications | LabVIEW 7.1 or later               |
| Spectral Measurements Toolkit; NI-SCOPE and NI-TUNER drivers | • Maximum flexibility for unique applications from a lower-level application programming interface  
• Provides full access to functionality provided by the drivers for the downconverter and digitizer modules | LabVIEW 7.1 or later, LabWindows/CVI 7.0 or later, C compilers capable of calling a 32-bit DLL |

Note The Spectral Measurements Toolkit is used to perform measurements on the acquired data regardless of configuration paradigm.

Programming the RF Vector Signal Analyzer in LabVIEW

To programmatically configure the RF vector signal analyzer hardware for data acquisition in LabVIEW, use the ni5660 VIs. These VIs control both the NI 5600 RF downconverter module and the NI 5620 IF digitizer module as a single instrument for frequency-domain and IQ data acquisitions. The ni5660 VIs are located on the LabVIEW function palette at Instrument I/O>Instrument Drivers>ni5660.

ni5660 LabVIEW VIs Programming Flow

Two programming flows are used with the ni5660 VIs: a frequency-domain acquisition programming flow and an IQ acquisition programming flow. Every application built using the ni5660 VIs must call the ni5660 Initialize and ni5660 Close VIs.
Frequency-Domain Measurements Programming Flow

Use the programming flow shown in the following figure to acquire data and perform frequency-domain measurements using the ni5660 VIs.

![Figure 3-3. Use the ni5660 Configure Spectral Settings VI and the ni5660 Read Spectrum VI when Acquiring a Frequency Spectrum](image)

IQ Acquisition Programming Flow

Use the programming flow shown in Figures 3-4 and 3-5 to acquire IQ data in single-shot or continuous modes, respectively.

![Figure 3-4. Use the ni5660 Configure IQ Settings VI and the ni5660 Read IQ VI when Acquiring Single-Shot IQ Data](image)
Example Applications for LabVIEW

Several example ni5660 VI applications are available for LabVIEW. These examples are intended to serve as interactive tools, programming models, and building blocks in your own applications.

All installed ni5660 example files are located in the `<LabVIEW home>\examples\instr\ni5660` folder.

LabVIEW examples also are available online at ni.com/examples that demonstrate integration of the NI RF Vector Signal Analyzer with NI RF Signal Generators and NI toolkit software, including the Modulation Toolkit. Refer to the NI Developer Zone on the Web at ni.com/examples for these examples and more information.

Programming the RF Vector Signal Analyzer in LabWindows/CVI and C

LabWindows/CVI and C users program the RF Vector Signal Analyzer hardware modules individually, using function calls to the Spectral Measurements Toolkit and the individual drivers for the downconverter and digitizer modules:

- The Spectral Measurements Toolkit contains specialized functions for programming the RF Vector Signal Analyzer hardware for frequency-domain and IQ measurements.
- The NI-SCOPE driver controls the NI 5620 IF digitizer module and triggering of the RF Vector Signal Analyzer.
Note  For more information on NI-SCOPE and triggering, refer to the *NI-High-Speed Digitizers Help*, located at Start»Programs»National Instruments»NI-SCOPE»Documentation.

- The NI-TUNER driver controls the NI 5600 downconverter module.

Note  For more information on NI-TUNER, refer to the *NI-TUNER Help*, located at Start»Programs»National Instruments»NI-TUNER»Documentation.

The NI-SCOPE and NI-TUNER software components are depicted in Figure 3-6.

![Figure 3-6. Flow Diagram for LabWindows/CVI and C](image)

Note  When programmatically operating the RF Vector Signal Analyzer hardware, specify the NI 5620 IF digitizer module using the DAQ Resource Name with the following syntax:

`DAQ::DeviceNumber`

Specify the NI 5600 RF downconverter module using the MAX device number without modifiers.
Introduction to the Spectral Measurements Toolkit

NI provides add-on software toolkits, such as the Spectral Measurements Toolkit (included) and the Modulation Toolkit, that extend the capability of the RF Vector Signal Analyzer to include frequency- and modulation-domain measurements, and analysis of analog- and digitally-modulated IF signals.

**Note**  You must install the Spectral Measurements Toolkit CD packaged with your RF Vector Signal Analyzer. The Spectral Measurements Toolkit is necessary for analysis of modulated signals using the RF Signal Analyzer.

Use the Spectral Measurements Toolkit (SMT) VIs and functions for frequency-domain analysis, measurement, and display of data acquired using the RF Vector Signal Analyzer. The SMT can perform several operations, including the following:

- Zoom FFT processing and spectrum averaging
- Spectral measurements such as band power, adjacent channel power, and peak frequency and magnitude
- Spectrogram display and analysis
- RF Vector Signal Analyzer hardware configuration for frequency-domain measurements

For complete information about SMT VIs and functions, refer to the Spectral Measurements Toolkit documentation, accessible from Start» Programs»National Instruments»Spectral Measurements»Documentation. For more information about the Modulation Toolkit, refer to the NI RF Signal Analyzers Help, accessible at Start»Programs»National Instruments»NI-RFSA»Documentation.

**SMT Example Applications for LabWindows/CVI and C**

The Spectral Measurements Toolkit includes LabWindows/CVI and C examples for the RF Vector Signal Analyzer hardware. You can access the Spectral Measurements Toolkit examples at Start»Programs»National Instruments»Spectral Measurements»CVI Support. The example files are located in the <CVI home>\samples\smt folder.
Configuring and Programming
Your NI 5661

Use Measurement & Automation Explorer (MAX) to configure your National Instruments hardware. MAX informs other programs about which devices reside in the system and how they are configured. MAX is automatically installed with the NI-RFSA driver.

**Note** MAX treats the NI 5600 downconverter module and the NI 5142 IF digitizer module as separate but associated devices. The MAX association is necessary for transparent operation of both modules as a single instrument (the NI 5661) using the NI-RFSA driver.

To use MAX to configure, self-test, and functionally test the RF vector signal analyzer hardware modules, complete the following steps:

1. **Note** If you do not see both the NI 5600 and NI 5142 modules listed, refer to Appendix B, *Troubleshooting*.
Rename Both Modules

MAX allows you to rename both NI 5661 hardware modules. The MAX name is used in software to operate the NI 5661 hardware resources. You do not have to change the module names from the default, but doing so can make programming easier.

To rename both NI 5661 hardware modules, complete steps 4 through 10.

4. Right-click the NI 5600 and select Rename from the shortcut menu.
5. Enter the new name for the NI 5600 module.

Note The device name must consist only of alphanumeric and underscore characters.

6. Click OK.
7. Right-click the NI 5142 and select Rename from the shortcut menu.
8. Enter the new name for the NI 5142 module.
9. Click OK.
10. Verify that the new names for both modules are displayed before proceeding to step 11.

Associate the IF Digitizer Module

You must create a MAX association between the NI 5600 downconverter module and the NI 5142 IF digitizer module to control both hardware modules as a single RF vector signal analyzer. Complete steps 11 through 13 to make this association.

11. Right-click NI PXI-5600 and select Properties.
12. In the NI 5142 Device Properties dialog box, use the drop-down listbox to specify the NI 5142 that is connected to the NI 5600 by front panel coaxial cables. Refer to the Interconnecting the Modules section of Chapter 2, Hardware Installation, for more information.

Tip If you rename the NI 5142 module after association, you must repeat the association. Association between NI 5661 hardware modules is lost when a previously associated IF digitizer module is renamed.

13. Click OK to exit the dialog box.
Programming the RF Vector Signal Analyzer in LabVIEW

To programmatically configure the RF signal analyzer for data acquisition in LabVIEW, you can use the NI-RFSA VIs. These VIs are located on the LabVIEW function palette at Instrument I/O » Instrument Drivers » NI-RFSA.

Example Applications for LabVIEW

Several example NI-RFSA applications are available for LabVIEW. These examples are intended to serve as interactive tools, programming models, and building blocks in your own applications. Refer to the NI RF Signal Analyzers Readme for information about the installation locations for LabVIEW example programs.

You can select Help » Find Examples from inside LabVIEW to use the NI Example Finder to search or browse examples. NI-RFSA examples are classified by keyword, so you can search for a particular device or measurement function.

LabVIEW examples also are available online at ni.com/examples that demonstrate integration of the NI RF vector signal analyzer with NI RF signal generators and NI toolkit software, including the Modulation Toolkit.

Programming the RF Vector Signal Analyzer in LabWindows/CVI and C

NI-RFSA also includes support for using LabWindows/CVI and C. The programming flow for using the NI-RFSA functions is the same as the programming flow you would use for LabVIEW programming.
Introduction to the Spectral Measurements Toolkit

NI provides add-on software toolkits, such as the Spectral Measurements Toolkit (included) and the Modulation Toolkit, that extend the capability of the RF Vector Signal Analyzer to include frequency- and modulation-domain measurements, and analysis of analog- and digitally-modulated IF signals.

**Note** You must install the Spectral Measurements Toolkit CD packaged with your RF Vector Signal Analyzer. The Spectral Measurements Toolkit is necessary for analysis of modulated signals using the RF Signal Analyzer.

Use the Spectral Measurements Toolkit (SMT) VIs and functions for frequency-domain analysis, measurement, and display of data acquired using the RF Vector Signal Analyzer. The SMT can perform several operations, including the following:

- Zoom FFT processing and spectrum averaging
- Spectral measurements such as band power, adjacent channel power, and peak frequency and magnitude
- Spectrogram display and analysis
- RF Vector Signal Analyzer hardware configuration for frequency-domain measurements

For complete information about SMT VIs and functions, refer to the Spectral Measurements Toolkit documentation, accessible from **Start» Programs»National Instruments»Spectral Measurements» Documentation**. For more information about the Modulation Toolkit, refer to the NI RF Signal Analyzers Help, accessible at **Start»Programs»National Instruments»NI-RFSA»Documentation**.
Hardware Front Panel Connectors and Indicators

The following sections describe the connectors and LED indicators on the front panels of both RF Vector Signal Analyzer hardware modules. All inputs and outputs are AC-coupled.

Note Refer to Figure 2-3, Installation of Included NI 5660 Cables, and Figure 2-4, Installation of Included NI 5661 Cables, for illustrations of standard RF vector signal analyzer hardware module front panel interconnections.
NI 5600 RF Downconverter Module

The NI 5600 downconverter module front panel contains six connectors and two LEDs, as shown in Figure A-1.

Figure A-1. NI 5600 RF Downconverter Module Front Panel

Note The PXI 10 MHz I/O connector can be used to route reference clock signals to the PXI backplane only when the NI 5600 downconverter module is installed in PXI Slot 2. This connector can export the PXI 10 MHz backplane clock from any NI 5600 PXI installation slot. Refer to the help file for your device for more information.
# Table A-1. NI 5600 RF Downconverter Module Front Panel Connectors

<table>
<thead>
<tr>
<th>Connector</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREQ REF IN</td>
<td>Routes an external frequency reference signal to which the NI 5600 can lock. This signal can be propagated to the PXI backplane when the NI 5600 is installed in PXI Slot 2.</td>
</tr>
<tr>
<td>10 MHz OUT</td>
<td>Connect the lower 10 MHz OUT connector to the REF CLK IN connector on the NI 5620 module front panel or to the CLK IN connector on the NI 5142.</td>
</tr>
<tr>
<td>10 MHz OUT</td>
<td>Both connectors output replications of the downconverter 10 MHz frequency reference signal, useful for driving other devices. Each replication is 180 degrees out-of-phase with the other. The signal output at these connectors is always on and cannot be disabled.</td>
</tr>
</tbody>
</table>
| PXI 10 MHz I/O | Bidirectional connection to the PXI 10 MHz backplane clock.  
This connector can be used to drive the PXI 10 MHz backplane clock only when the NI 5600 is installed in PXI Slot 2. This connector can be used to export the PXI 10 MHz backplane clock when the NI 5600 downconverter is installed in any PXI slot. Refer to the help file for your device for more information. |
| OUTPUT       | Connect to the INPUT connector on the IF digitizer module front panel.  
Outputs the frequency-translated IF signal for digitization. |
| INPUT        | Connect to the analog RF input signal to be measured by the RF Vector Signal Analyzer. |
### Table A-2. NI 5600 RF Downconverter Module Front Panel LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Indications</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER</td>
<td>Indicates the basic hardware power status of the NI 5600 downconverter module. This LED functions identically to the ACCESS LED on the digitizer module front panel.</td>
</tr>
<tr>
<td></td>
<td>OFF—The module is not yet functional or has detected a problem with a PXI power rail.</td>
</tr>
<tr>
<td></td>
<td>GREEN—The module is functional and receiving power.</td>
</tr>
<tr>
<td>STATUS</td>
<td>Indicates the status of the NI 5600 downconverter module PLLs.</td>
</tr>
<tr>
<td></td>
<td>OFF—The module is in an uninitialized state, or the module PLLs are attempting to lock.</td>
</tr>
<tr>
<td></td>
<td>GREEN—The module is in a ready state; applicable PLLs are locked.</td>
</tr>
</tbody>
</table>
NI 5620 IF Digitizer Module

The front panel of the NI 5620 IF digitizer module contains three connectors, as shown in Figure A-2.

Figure A-2. NI 5620 IF Digitizer Module Front Panel
## Table A-3. NI 5620 IF Digitizer Module Front Panel Connectors

<table>
<thead>
<tr>
<th>Connector</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td>Input terminal for a frequency-translated IF waveform from the NI 5600 downconverter for digitization and measurement. Connect to the OUTPUT connector on the NI 5600 downconverter module front panel.</td>
</tr>
<tr>
<td>REF CLK IN</td>
<td>Input terminal for the NI 5600 internal reference clock signal. Connect to the lower 10 MHz OUT connector on the NI 5600 downconverter module front panel.</td>
</tr>
<tr>
<td>PFI 1</td>
<td>Input terminal for a digital trigger from an external source. Refer to the <em>NI High-Speed Digitizers Help</em> for more information about triggering.</td>
</tr>
</tbody>
</table>
NI 5142 IF Digitizer Module

The front panel of the NI 5142 IF digitizer module contains three connectors, as shown in Figure A-3.

Figure A-3. NI 5142 IF Digitizer Module Front Panel
### Table A-4. NI 5142 IF Digitizer Module Front Panel Connectors

<table>
<thead>
<tr>
<th>Connector</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH 0</td>
<td>Input terminal for a frequency-translated IF waveform from the NI 5600 downconverter for digitization and measurement. Connect to the OUTPUT connector on the NI 5600 downconverter module front panel.</td>
</tr>
<tr>
<td>CH 1</td>
<td>This input terminal is not used for NI 5661 operation. CH 0 is the only channel with digital downconverter (DDC) capabilities.</td>
</tr>
<tr>
<td>TRIG</td>
<td>Input terminal for a digital trigger from an external source. Refer to the <em>NI High-Speed Digitizers Help</em> for more information about triggering.</td>
</tr>
<tr>
<td>CLK IN</td>
<td>Input terminal for the NI 5600 internal reference clock signal. Connect to the lower 10 MHz OUT connector on the NI 5600 downconverter module front panel.</td>
</tr>
<tr>
<td>CLK OUT</td>
<td>Output terminal for the NI 5142 reference or sample clock.</td>
</tr>
<tr>
<td>AUX I/O</td>
<td>Provides access to the multipurpose digital timing and triggering lines, PFI 0, and PFI 1 (with optional cable).</td>
</tr>
</tbody>
</table>
Troubleshooting

This section discusses issues you may encounter during installation, configuration, and use of the RF vector signal analyzer hardware and software. Refer to the Related Documentation section of About This Manual chapter for information about other documentation that may be helpful to you.

Installation

NI 5600 RF Downconverter Module Front Panel POWER LED is Off When PXI Chassis is On

If the POWER LED fails to light when the PXI chassis is powered on, a problem may exist with the PXI power rail, a hardware module, or the LED. Complete the following steps to troubleshoot this issue:

1. Power off your PXI chassis.
2. Remove any module front panel interconnections between the RF Vector Signal Analyzer hardware modules.
3. Remove both RF vector signal analyzer hardware modules and inspect for damage. Do not reinstall a damaged device.
4. Reinstall both RF vector signal analyzer hardware modules in different PXI slots. Use the procedure detailed in Chapter 2, Hardware Installation.
5. Power on your PXI chassis.
6. If the POWER LED still fails to light, and failures continue, contact NI technical support or visit ni.com/support.
A Hardware Module Does Not Appear in MAX

Use the following procedure if either RF vector signal analyzer hardware module does not appear in MAX:

1. In the MAX Configuration pane, expand one of the following folders:
   a. For the NI 5620, expand the **Traditional NI-DAQ Devices** folder.
   b. For the NI 5600 or NI 5142, expand the **NI-DAQmx Devices** folder.
2. Press <F5> to refresh the list of installed devices.
3. If either module is still not listed, power off the system, ensure that the RF vector signal analyzer hardware is correctly installed, and restart the system. If your hardware still does not appear, continue to step 4.
4. Open the Windows Control Panel and select **System»Hardware»Device Manager**. Complete the appropriate step for your setup:
   - If using a PXI controller, verify that a **National Instruments** entry appears in the system device list. Reinstall the driver software CD and the RF vector signal analyzer hardware modules if error conditions are present in the list.
   - If using a MXI-3 controller, right-click **PCI-to-PCI Bridge** and select **Properties** from the shortcut menu to verify that the bridge is enabled.
5. If either module still fails to appear in MAX, contact NI technical support or visit **ni.com/support**.

The NI 5600 RF Downconverter Module Fails the Self-Test

The MAX self-test performs a brief test of device resources. If the NI 5600 does not pass the self-test, complete the following steps:

1. Reboot your system.
2. Launch MAX and perform the self-test again. If the module still fails the self-test, proceed to step three.
3. Uninstall the RF vector signal analyzer software using the **Add/Remove Programs** option on the Windows Control Panel. Never attempt to uninstall by deleting files. For more information about uninstalling the NI-RFSA software, refer to the **NI RF Signal Analyzers Readme**.
4. Reinstall the driver software by running **setup.exe** on the driver software CD that shipped with your RF vector signal analyzer.
5. If the NI 5600 downconverter module still fails the self-test, contact NI technical support or visit **ni.com/support**.
The IF Digitizer Module Fails the Self-Test

The MAX self-test performs a brief device resources test. If the IF digitizer module does not pass the self-test, complete the following steps:

1. Launch MAX by navigating to **Start»Programs»National Instruments»Measurement & Automation** or by clicking the MAX desktop icon.
2. In the Configuration pane, double-click **Devices and Interfaces** to see the list of installed devices.
3. In MAX, expand one of the following folders:
   a. For the NI 5620, expand the **Traditional NI-DAQ Devices** folder. You will see a list of installed devices that includes the NI 5600 and NI 5620 IF digitizer modules.  
      * Right-click the IF digitizer module name and select **Properties**.
      * The Configuring Device dialog appears. Click **Test Resources**.
      * In the Configuring Device window, select **Run Test Panels**. The test panel performs a functional test of the IF digitizer module.
   b. For the NI 5142, expand the **NI-DAQmx Devices** folder. You will see a list of installed devices that includes the NI 5600 and NI 5142 IF digitizer modules.  
      * Right-click the IF digitizer module name and select **Self-Test**.
4. Click the **Start** button to run the test panel.
5. When the test panel has run successfully, click **Close**.
6. Click **OK** in the Configuring Devices window to return to MAX.
7. If the test panel fails and continues to fail, contact NI technical support or visit [ni.com/support](http://ni.com/support).
Appendix B  Troubleshooting

Configuration

RF Vector Signal Analyzer Does Not Initialize

Failure to initialize may indicate a problem with module interconnection or with MAX. If the RF vector signal analyzer fails to initialize, complete the following steps:

1. Reconnect the RF vector signal analyzer hardware module front panel cables securely as shown in Chapter 2, *Hardware Installation*.

2. Power on your system and run the MAX configuration and self-test procedures in either Chapter 3, *Configuring and Programming Your NI 5660* or Chapter 4, *Configuring and Programming Your NI 5661*.

3. If failures continue, contact NI technical support or visit ni.com/support.

STATUS LED Does Not Light

If the RF vector signal analyzer is programmed to lock to an external reference source or to the PXI backplane, but the STATUS light does not indicate a phase locked status, check for the following errors:

1. Make sure a cable is connected from the external source or the PXI 10 MHZ I/O connector to the FREQ REF IN connector.

2. Ensure that the external source signal is large enough—typically greater than –10 dBm.

3. Ensure the external source signal falls within the specified frequency accuracy.

If you programmed the RF vector signal analyzer to use the NI 5600 downconverter module internal timebase, check for the following errors:

1. If the RF vector signal analyzer measures the frequency incorrectly or detects no signal when one is supplied, one or more of the local oscillators is not phase-locked.

2. If the RF vector signal analyzer measures the frequency correctly but the LED does not light, there could be a driver software error or the LED is damaged.

3. If failures continue, contact NI technical support or visit ni.com/support.
The IF Digitizer Module Does Not Phase-Lock to the RF Downconverter Module

If you programmed the IF digitizer module to phase-lock to the NI 5600 downconverter module internal reference through the front panel and you encounter failure, first verify that the cable is not faulty. Next, verify that there is a reference signal output from the NI 5600 10 MHZ OUT front panel connectors. If there is no signal at these outputs, contact NI.

If you programmed the IF digitizer module to phase-lock to the PXI backplane driven by the NI 5600 downconverter module internal reference and you encounter failure, make sure that the NI 5600 is in Slot 2 of the PXI chassis, immediately adjoining the PXI controller slot. Also verify that the PXI 10 MHZ I/O connector is securely wired to one of the 10 MHz OUT connectors using the included cable, as shown in Chapter 2, Hardware Installation. If failures or errors continue, contact NI technical support or visit ni.com/ask.

If failures or errors continue, contact NI technical support or visit ni.com/support.

Measurements

For more information about making measurements with the RF Vector Signal Analyzer, NI 5661 users can refer to the NI RF Vector Signal Analyzers Help, and NI 5660 users can refer to the NI PXI-5660 Help.
RF Vector Signal Analyzer Amplitude Reading Does Not Match Source

If the RF vector signal analyzer reports an incorrect amplitude reading, check for the following possible errors:

1. Check that the discrepancy between the RF vector signal analyzer and the source is within the error limits of the devices, as follows:
   a. Verify the absolute amplitude accuracy of the RF vector signal analyzer.
   b. Verify the output level accuracy of the source.

2. Check for loss in the cables, which can be substantial. For example, RG58 coaxial cable loses about 2.1 dB of signal amplitude per foot at 2 GHz. Unless you are using high-quality cables, expect losses when working with high-frequency signals.

3. (NI 5660) Ensure that you are using the amplitude calibration functions in the Spectral Measurements Toolkit. Failure to apply calibration functions can result in large amplitude errors.

4. If errors continue, contact NI technical support or visit ni.com/support.
Visit the following sections of the National Instruments Web site at ni.com for technical support and professional services:

- **Support**—Online technical support resources at ni.com/support include the following:
  - **Self-Help Resources**—For answers and solutions, visit the award-winning National Instruments Web site for software drivers and updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting wizards, thousands of example programs, tutorials, application notes, instrument drivers, and so on.
  - **Free Technical Support**—All registered users receive free Basic Service, which includes access to hundreds of Application Engineers worldwide in the NI Discussion Forums at ni.com/forums. National Instruments Application Engineers make sure every question receives an answer.

  For information about other technical support options in your area, visit ni.com/services or contact your local office at ni.com/contact.

- **Training and Certification**—Visit ni.com/training for self-paced training, eLearning virtual classrooms, interactive CDs, and Certification program information. You also can register for instructor-led, hands-on courses at locations around the world.

- **System Integration**—If you have time constraints, limited in-house technical resources, or other project challenges, National Instruments Alliance Partner members can help. To learn more, call your local NI office or visit ni.com/alliance.

- **Declaration of Conformity (DoC)**—A DoC is our claim of compliance with the Council of the European Communities using the manufacturer’s declaration of conformity. This system affords the user protection for electronic compatibility (EMC) and product safety. You can obtain the DoC for your product by visiting ni.com/certification.
• **Calibration Certificate**—If your product supports calibration, you can obtain the calibration certificate for your product at [ni.com/calibration](http://ni.com/calibration).

If you searched [ni.com](http://ni.com) and could not find the answers you need, contact your local office or NI corporate headquarters. Phone numbers for our worldwide offices are listed at the front of this manual. You also can visit the Worldwide Offices section of [ni.com/niglobal](http://ni.com/niglobal) to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.